Acid Basics

The Acid Graphic User Interface has three main areas; the timeline area, the track list area and the windows
docking area.
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The Windows docking area can contain multiple
windows. These windows can be turned on and Play Stop Auto
off from the view menu. The Explorer Window Preview | | Preview | | Preview

is on by default when you load the software.
This window enables access to files stored on = \b i - ‘E/ .
the computer hard drive and portable storage Q& R @ ! (33

devices. The Explorer window has folders in a

tree view on the left hand side; the files appear LS sl

on the right hand side. Turn the “‘Auto Preview’
button on to audition files.
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The Explorer window also contains information about audio files that are selected. In the example above
the Rock-Pop 22 Clarinet & Oboe 01 file is selected. Acid recognises that this file is a loop that has an 8
beat duration. The recorded tempo was 90 beats per minute (BPM). The pitch was based around the note F
in the third octave (F3). It is an uncompressed audio file with a sampling rate of 44.1 Hertz and a bit depth
of 16.

As this file is a loop, its tempo and pitch will change to the e
Acid Project file settings. The project pitch and tempo . 120000 4 5
settings are located at the bottom of the track list area. The BPM 4 o
default settings are a tempo of 120 BPM in 4/4 time using Ds
the key (pitch) of A. The tempo slider is used to edit the ~\ E
project tempo. Double click on the slider control to return ~~ lﬁ 159.852 4 pp_, =
to the default setting. Click on the key letter name to BPM 4 ¢
change the key. e
.

Adding Files to the Project

Files can be added to the timeline by dragging them from the
Explorer preview window or by double clicking on them. A track
header will appear in the track list area.

= Rock-Pop 22 Cl... @B~ TE~O |
-6.0 dB {m}  Center — (I &2...

A track for the loop has been created in the timeline area. Hold your Track List Area
mouse on a track in the timeline. Your cursor will change to a pencil,

the loop can now be drawn into the timeline. The following example
has been drawn for a total of 8 bars.

1'1'000 1.1 \91 17.1

Draw in the timeline
at the required bars

=10 | Rock-Pop 22 Cl... @ =lle= £¥ - O [ | {2 Rock-Pop 22 Clarinet & Oboe
-6.0 dB {n}  Center —{1J— &...

Indentations on the datum
show the repeat of a loop

Use the transport controls to play the file. The space bar is the short cut to play and stop. The enter key is
the short cut to pause. A black playback line moves across the timeline when playing to show the position
in time.

@ O/ Il | WM @‘f|

Zooming

The scroll wheel on your mouse can be used to zoom in and out, additional bar numbers will be shown
when you zoom in.

1.1 21 h 4l \5.1 6.1 ! 8.1

47 Rock-Pop 22 Clarinet & Oboe 01 SIS i FT - e T
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Standard windows zoom in and out tools are located on the bottom right hand corner of the timeline. Zoom
in and out track height tools are also located here.

The Track height can also be adjusted by holding the mouse
over the bottom of a track header. Use this method to resize
Scroll Bars any window in Acid.

=W rock-Pop 22 Clarinet... @ i+~ © |

,:' ock-Pop 22 Clarinet & Oboe 01
Zoom Track Height Vol: -6.0 d8 G B roudh s [T —
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Pan: Center 10 ' Rock-P...

1
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Adjust Height

v = by Dragging
== el

Zoom In and Out

Deleting

Click on datum in the timeline and press delete to remove material from the timeline. Click on the track in
the track list area and press delete to remove the entire track. In the following example track 2 has been
selected and has focus. The track with focus is shaded blue; the entire track can be removed from the
project by pressing delete.

& B Rock-Pop 22 Clarinet & ... @ 8~ £x~® ! | N@ Rock-Pop 22 Clarin
Vol: -6.0dB8 —{Il} Pan: Center — 1] @...| |ouimpii— —ouipmpie—=
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Vol:[36.0d8 ——1) Pan: Center )  El.. Rt

The Cursor

The appearance of the cursor changes when you hold the mouse over different parts of a clip/media in the
timeline.

i 51 | Thewhite arrow indicates that a clip can be selected for deletion; it is also used to
2 Rock-Fop 22 Clannet & | move the clip along the timeline.

5.1 o. | The cursor changes to a hand when held at the top of a clip. The gain (volume) can
.,,_.'_@__,___ then be adjusted by dragging up and down.

"“"'151"- is -0.9 dg]

1321 | The cursor changes to an arched shape
when held over a top corner of a clip.
Fade Ins (top left side) and Fade Outs (top

Ocll 5.1 9.1

P |
Gain at 2.0.000 is 0.0 dB
enal |

131

Fade Out

|Gain at0.0.000 s 0.0 dB}

right side) can be added with this tool.
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In the example above, a 2 bar fade out was added by dragging the mouse. The fade “snaps” to the
beginning of a bar, as by default the snap feature is activated and set to bars (measures). This also means
that clips can only be drawn at the beginning of a bar.

This feature can be turned off by clicking on the ‘Enable Snapping’ =——>

Ruker Marks

button which is located on the main tool bar. This button also has a drop ‘ -E::’R v ‘

Half Notes ]

down menu which allows you to set the snapping to smaller bar Quarter Notes
divisions. e o T
8th Note Tripiets
When the mouse is held over the left or right hand side of the middle of a clip the cursor e
changes to a rectangle, the clip can be dragged in and out to change the length/duration. o trpets

Solo and Mute Buttons

Each track has a Solo and Mute button.

G4th Notes
B4th Note Tripiets

=P 120bpm_E Drums 1 | Mute
Vol: -6.0 dB i Pan: nter

-—e+®_}
).

Solo

Changing the Pitch

The key setting mentioned earlier is a global setting and affects the entire project. Key changes can be
inserted at any point in the project. Place the playback line at the desired position and then go to the Insert
menu and select ‘Tempo/Key/Time Signature change. Select a new key.

r

Tempo/Key/Time Signature Change

[?)X

Lo |

[v] ey change: C T},.
MNone

[¥| Tempo change (BPM):
C#
|:|Time Signature change: (D
D#

F#

Cancel

The pitch of clips can also be changed. This is done by
selecting the clip and then using the + and — keys on the
computers numeric keypad. This will raise or lower the
pitch by one semitone.

+ = Up 1 Semitone

- = Down 1 Semitone

Shift + = Up 4 Semitones

Shift - = Down 4 Semitones

Control + = Up 12 Semitones (1 Octave)

Control - = Down 12 Semitones

To split a clip, place the playback line at the required position and then press *S’ or go to the Edit menu and
select “Split’. In the following example an 8 bar loop had already been drawn into the timeline. The loop
was then split to enable pitch changes to smaller sections.

1.1 . . 5.1

@ Rocl@ Rocf@ RocH@ Roclf @
mempangpy 2 (B:] +3 (C} +5 I:D‘l
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Volume

— A projects volume can me adjusted using the Mixer controls in the windows docking area.
RO ! The volume for an entire track can be adjusted using the controls in the track header (track list
area). A clips volume can be adjusted by holding the mouse at the top of a clip and dragging
the gain line up and down.

Volume Envelopes can also be added to a clip. Right click on a clip and select ‘Insert/Remove
Envelope’, then “Volume’. A blue line will now appear on the track. Double click on this line
to add points; the points can then be dragged up and down to adjust the gain/volume. The
points will snap to the selected bar division if the Enable Snapping button is on.

Right click on a point to access further settings or to type in the
required volume (in Decibels).

The Chopper

The length of a clip can be changed by dragging or it can be opened in the *‘Chopper’. Right click on a clip
and select “Select in Chopper’ or turn the Chopper on in the View menu. The Chopper will then appear in
the Docking area. Click on the Chopper Tab at the bottom of the screen to view the chopper. The selected
clip will appear in the Chopper.

| Chopper: HH_Turntable_Thatsright

Select the required section of
a clip and then use the Insert /—
controls to add the selection

to the timeline. . ]

i
00:00:00:00 00:00:01:00 '00:00:02:00 ' '00:00:02:00 ' 'a0:00:0
< ===

(G| | 1.2.113 1.3.322 0.1.208

Recording

Place the playback line at the required position and then press the Record button on the Transport bar. Press
stop or the space bar when finished. A dialogue box will appear asking if you wish to keep the recording.

A new track will be added to your project. Acid enables recording onto multiple tracks; insert additional
audio tracks and arm them for recording before pressing record on the transport bar.

- —
—J ) M@ -0 @ 1 Clip
LDt 136 24 120 RUR

~a
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MIDI Tracks

To add MIDI tracks go to the Insert Menu and select ‘MIDI track’ (or right click in a blank section in the
track area and select). Acid uses soft synthesizers for the Output (sound source) of MIDI tracks. The Sony
DLS Soft Synth will be loaded by default when you add a MIDI track. Click on the ‘Insert Soft Synth’
button on the Mixer toolbar to access other soft synths.

N o 5P

Insert Soft Synth

A ‘Soft Synth Chooser’ Dialogue box will appear, select a soft synth and then click on OK.

Product Name Type | Vendor

Kompakt Sony ACID Pro edition Kompakt Sony ACID Pro edition VSTi Native Instruments Software 5
Sony DLS Soft Synth DLS Soft Synth DLS  Sony Media Software, Inc.

The Kompakt Sony Acid Pro edition Soft Synth

@ KOMPAKKT Sony’ ACID" Pro edition [J1

= NMEW MULTI ssx ENSEMBLE STRING

Sounds can be Edited and Saved

’“@ """@

TR “ L

Eight different instruments, drum Kits, sound effects etc can be loaded into a Kompakt synth. Up to 32 soft
synths can be inserted into Acid Pro 6, giving you a total of 256 available MIDI instruments when using the
Kompakt Synth. In the example above a Rhodes Keyboard has been loaded to channel 1, a Timpani has
been loaded to channel 2 and an Ensemble Strings Synth has been loaded to channel 3. Channels 4 — 8 are
empty. Select the MIDI Output button on a MIDI track to select the soft synth and the required
channel/instrument.
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teenage mut i
| Select MIDI Output

@ -114d —F {1 @-2f &[0!

= Bl rhodes Keyboard @B TE-0 1

100 L)~ Center U output off

S EH Timpani (OR:]

100 i Center (1]}  External MIDI Device Preferences...

= Bl Ensemble Strings (O]

n Soft Synth 1 (Kompakt Sony ACID Pro edition)
100 ] Center (1]

Soft Synth 2 (DLS Soft Synth)
Soft Synths can also be _,JT!!I Insert Soft Synth.. Select Channel 1

Inserted from the tracks for Rhodes Keyboard,
MIDI Qutput Menu MIDI Channel Channel 2 for Timpani,

Channel 3 for Strings

Arm the track for recording and then press Record on the main Transport Bar.

= [ rRhodes Keyboard ®EY ~® 1 I =
a v o @,\o IDPHHP—H—ﬁ—D@)*‘
100 LI}~ Center < ML..

— Arm for Recardf

S Record MIDI Step Record || MIDI Merge Record

Step MIDI Recording enables you to select the note duration; notes of this
duration will then be entered, regardless of how they are played on your MIDI
keyboard. The Step Record dialogue box appears when the MIDI Step Record
button on the Transport Bar is pressed. Note durations, Tuplet settings and
Velocity (maximum of 127) can be selected here. Check the ‘As Played’ box Duration: & Y7 = ticks
to record the velocity level from your MIDI keyboard.

Step & v['\\i = ticks

[ITuplet: in time of

Velocity: | &4 :]a\s Flayed

MIDI Merge Recording enables you to keep the existing recording; additional recordings on an armed track
will be added to the original recording.

You can record onto multiple tracks by arming additional tracks for recording. MIDI clips will appear on
the timeline when you have stopped recording.

~» MIDI Recording - 1 |
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The Sony DLS Soft Synthesizer

Select the DLS soft synth from the ‘Soft Synth Chooser’ dialogue box. This soft synth allows 16
instruments (a total of 32 DSL synths may be loaded into Acid Pro 6 giving you a total of 512 instruments),
drum Kits, sound effects etc to be loaded. Select the channel and then allocate a sound by clicking on an
instrument in the ‘Available Voices’ list. Set the MIDI tracks Output to ‘DLS Soft Synth’.

Product Name Type Wendor

Kompakt Sony ACID Pro edition Kompakt Sony ACID Pro edition VSTi  Native Instruments Software S
Media Software, Inc.

DLS Soft Synth DLS Soft 5

Soft Synth 1 (Kompakt Sony ACID Pro edition)
B soft synth 2 (DLS Soft Synth)
M Insert Soft Synth...

Voice set: |GS sound set (16 bit)

1 44— Select Channel

Channel

Available voices:

Select Instrument

MIDI Channel Select Channel ——p »
Type Patch name Patch # Bank MSB Bank LS *
J Voice [E car-Cras 4 0
lvoice | ] Volume and Pan Envelopes yr—————
ﬁg:: g JTffirane i;g g : can be added and removed +8-61 |+8-61
y Sl — i from a MIDI track by =7 s
J:_ NB When using soft synths, Drum Kits pressing the V and P keys 135 428 133 132
< can be loaded to any channel on your computer keyboard. -4 o i i
Like Audio, each MIDI I s
track has a volume fader. i i;
: g s The soft synths have Global
£ I Use Keyboard to Audition Sounds I Vo_lume Settmgs in the Mixer
Window.

MIDI Editing

MIDI clips can be added or edited using the ‘Clips Properties” window or the ‘Inline MIDI’ editing feature.
Add a MIDI track or select an existing MIDI recording, go to the View Menu and select ‘Clip Properties’.
The Clips Properties has two tabs; Piano Roll Editing and List Editing.

Fiano Roll Editor | List Editor

X ® oW - [Z]% 2 - # 1 4|7
“'g E . . 13 . . 21 . . . 23 . . 21 =
C Major Scale Scroll to View Octaves

\ Drawn as Crotchets Octaves are Colour Coded
e~ Enable Snapping is Onand  C8is Middle C . f======

|5 Set to 1/4 notes (crotchets)——

Nes—

— e — e ———r '] :
— < s Use the Paint Tool to quickly ' _

= Vealocity 127 r
X " |

o
Select MIDI <

Contollers Here ¢ s 1 @ 1 ™

Edit Controllers Here
S

add notes of the same duration
Setihe Paint and Enable Snapping
to the reqﬁired note duration

> &

106
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The Inline MIDI Editor enables editing to be done on the timeline. Press the Inline Editor Button —» Fﬁl
(on the toolbar) or the letter ‘G’ on your computer keyboard to turn the editor on. -

- Hold the mouse over an event in the

Closed Hi-hat ; ; ;
g Inline Editing has a MIDI Inline Editor, the Pl_tch ofa note_or
Electric Snare Drum Grid and Piano Roll the name of a percussion instrument will
Hand Clap appear in the bottom right hand corner of

Acoustic Snare . . . -
Side Stick the timeline. Velocity levels will also

Bass Drum 1 |
258 b 1 Notes and Controllers appear here.

MIDI Clip - 5 can be edited

4

Use the Pencil to Drag out a blank Uf% %
area - then add notes with the pencil
Use the Paint Tool to add

notes without dragging >\ - a .
| Bass Drum 1 Velocity = 64

Adding Audio Effects

Audio Effects can be added to audio tracks by clicking on the tracks FX button. The default EQ dialogue
box will open, click on the Edit Chain button to browse effects plug-ins stored on your computer.

e | L K* =

Vol: -7.0 dB

Pan: Center {1} B Edit Chain.

S ExpressfX Reverb A new Plug In dialogue box will appear enabling editing of the effect.
H ExpressFx Stutter
R ExpressFx Time Stretch
iTiFange/Wah-Wah
& Gapper/Snipper
ifiGraphic Dynamics
HeGraphic £Q (Bl Tacks  Add and Remove FX Buttons q:; &
i#iMulti-Band Dynamics o it )|
F Mult-Tap Delay S - Uncheck the 9
¥ Nose Gate o[ Track EQ_|—|[#|ExpressFx Delay | -
e Noise Reduction FX to disable
& Paragraphic EQ Bk Unuied) w ?
¥ Parametric EQ v - WX 7
e Pitch Shift e B = :
SONY. ExpressFX Delay P
ExpressFX Equalzation i¥iResonant Fiter — g
T ExpressFX Fange/Wah-wah  TiReverb The Plug In has some Presets Delay
% ExpressFX Graphic EQ ifisimple Delay e (0.0 1 100 550 %
ExpressFX Nose Gate itismooth/Enhance Dl 0lb Ell.'lrﬂ:v)D Y]
Degay (0.0 10 90.0 %)
O 00

Experiment by Adjusting the Sliders

450 %
Original
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